LibreOffice Calc for
Data Cleaning

What is a spreadsheet?
A tool for holding data in rows and columns.

Why use spreadsheets?
For disposable data-cleanup or visualization...

Reference: Naidoo, H (Hush Naidoo Jade Photography), October 2020, Unsplash License,
https://unsplash.com/photos/SutAduhzdRQ
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What are
Spreadsheet Tools?



Examples of Spreadsheet Tools

X

Excel is Microsoft’s
standalone spreadsheet
program. Available with the
Office suite.

LibreOffice Calc is the
Document Foundation’s free
open-source spreadsheet
program. Available here:
www.LibreOffice.org

WHAT ARE SPREADSHEET TOOLS?

Google Sheets is part of
the Google Apps Suite. If
you have a Gmail and

Google Drive, you have it.


http://www.libreoffice.org

What Can/Can’t LibreOffice Calc Do?

Formulas

Charts & Graphs

Auto-formats fields

Allow creation of lookup lists

Allow character sets besides Latin1 (e.g., UTF-8)
Track changes after closing

Maintain integrity between rows and columns

Enforce referential integrity between different sheets

Excel

Limited
Limited
Limited

Limited

LibreOffice Calc

Limited
Limited

Limited

WHAT ARE SPREADSHEET TOOLS?

Google Slides
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Limited

Limited
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Spreadsheet Don’ts

What should you AVOID doing in a spreadsheet?

e Mixing multiple
datasets in a single
spreadsheet

e Using multiple tabs in
a workbook

e Not filling in zeros

e Using problematic
null values (e.g.,
-999, +/-, Null, NA)

e Using visual

formatting
(color-highlights,
fonts, borders) to
convey information

Using visual
formatting to make
the data sheet look
pretty

github.com/datacarpentry/spreadsheet-ecology-lesson/blob/gh-pages/_episodes/02-common-mistakes.md

e Placing comments or
units in cells

e Entering more than
one piece of
information in a cell

e Using problematic
field names

WHAT ARE SPREADSHEET TOOLS?

e Using special
characters in data
(e.g., line breaks,
em-dashes, quotation
marks)

e Inclusion of metadata
in data table

P.S. DO NOT MERGE
CELLS. DO NOT. BAD.
SHAME.

r=m



WHAT ARE SPREADSHEET TOOLS?

Tables vs. Spreadsheets

Tables: Spreadsheets:

e = records & attributes ¢ = rows & columns

illusion of structure

actual structure

accident-prone data...

safer data. ..

e 1 Excel file can hold multiple
spreadsheets = more illusion...
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o



Getting Data into Calc



Getting Data
into Calc

e Open LibreOffice.

e From the File menu, click Open...
to open the data file. If the data is
saved in a standard format such
as a .csv, LibreOffice will open it
in Calc by default.

Practice Database.odb - LibreOffice Base
_Eile Edit View Insert Tools Window

[ New » fo7

|~ Open.. Ctrl+O

C'—:) Recent Documents » L E
[B

sheets_2020q4 4
8dp

E>
jre-8u333-windo
[] Read-only

GETTING YOUR DATA

= - m @
r N
' Eaj a :
How to dataworkshop-cs = WorkshopDatase
OpenRefine for v £

Data Cleanup v2
(Working Intern...

L &

openrefine-win-3 ZA _Connect openrefine-win-3 v

me: ‘WorkshopDataset

v | Al fles v

Version:




Getting Data
into Calc

e A Text Import wizard will open.

e Certain options will be selected
by default. Review them to make
sure the settings are fit for the
data file.

— Latin-1 and UTF-8 are the

most common character sets.

e [f something seems off in the
preview window at the bottom of
the wizard, try adjusting the
Separator Options.

@ ® Text Import - [WorkshopDataset.csv]
Import
Character set: Unicode (UTF-8)
Language: Default - English (USA) e
From row: 1 2
Separator Options
Fixed width © Separated by
Tab Comma Semicolon Space Other
Merge delimiters Trim spaces String delimiter: " ﬂ
Other Options
Format quoted field as text Detect special numbers
Evaluate formulas
Fields
Column type:
|[Standard  |Standard |Standard |standard |Standard |standard
1 ADP number Cat Numb Accesion year ACC_N  Former number count ir
2 ABCD:1 1993 9999 1
3 ABCD:2 1993 9999 1
4 ABCD:3 1993 9999 i
5 ABCD:4 1993 9999 2
6 ABCD:5 1993 9999 1
7 ABCD: 6 1993 9999 1

GETTING YOUR DATA



Getting Data
into Calc

e When everything looks good,
click OK. The data will open in a
Calc file.

@ WorkshopDataset.csv - LibreOffice Calc

" File Edit View Insert Format

E-E-H- D& B XBh-1£ 4

Liberation Sans

Styles

Sheet

Data

GETTING DATA INTO A SPREADSHEET TOOL

Tools Window Help

vlfopt MBI U+ AR~

T »

Average: ; Sum

A1 v fy 3. v = ADP number
| A B C D | E F G

FBNADP number |Cat Numb Accesion year ACC N Former number count in lot Specimen identifier's name
2| TABCD:1 1993 9999 1 Heiser, J., 1993
3| 2ABCD:2 1993 9999 1Heiser, J., 1993
"4 3ABCD:3 1993 9999 1 Heiser, J., 1993
5 | 4ABCD:4 1993 9999 2Heiser, J., 1993
"6 | 5ABCD:5 1993 9999 1 Heiser, J., 1993
7 6ABCD:6 1993 9999 1Heiser, J., 1993
_ 8 | 7ABCD:7 1993 9999 3 Per label supplied
"9 | 8ABCD:8 1993 9999 1 Heiser, J., 1995
10 | 9ABCD:9 1993 9999 7Heiser, J., 1995
11| 10ABCD:10 1993 9999 1 Heiser, J. 1993
El 11ABCD:11 1993 9999 2Heiser, J. 1993
Etl 12 ABCD:12 1993 9999 1 Heiser, J. 1993
14| 13ABCD:13 1993 9999 1 Heiser, J. 1993
15 | 14ABCD:14 1993 9999 1 Heiser, J. 1993
16 | 15ABCD:15 1993 9999 3Heiser, J. 1993

<
¢ 4 » ) =4 WorkshopDataset
Sheet 1 of 1 Default English (USA) =i

LD.



Getting Data
into Calc

e When everything looks correct,
click OK.

e Calc will open as a live date file.

— Using Save (from File menu)
after making any edits and
selecting the Use Text CSV
Format option will overwrite
the original data file.

— Instead, select Use ODF
Format or use Save As....

@ WorkshopDataset.csv - LibreOffice Calc

File Edit Vi

iew Insert Format Styles

Sheet

BE-B-H-D&@E XBhE- &£ 45

Liberation Sans

A1l
A

v]fopt MBI U+ A-R8-

v fx 3. v = ADP number

B

| @

| o | E

I

GETTING YOUR DATA

Data Tools Window Help

J& ab | - i -1 [BR] 54 %
=== = & J [
= = T T = le

| _F | 6 |

LWIADP number_[Cat Numb

)

Sheet 1 of 1

TABCD:1
2ABCD:2
3ABCD:3
4ABCD:4
5ABCD:5
6ABCD:6
7ABCD:7
8ABCD:8
9ABCD:9

10ABCD:10

11ABCD:11

12 ABCD:12

13ABCD:13

14ABCD:14
15ABCD:15

Accesion year ACC N Former number countinlot Specimen identifier's name -
1993

4= WorkshopDataset

Default

1993
1993
1993
1993
1993
1993
1993
1993
1993
1993
1993
1993
1993
1993

9999
9999
9999
9999
9999
9999
9999
9999
9999
9999
9999
9999
9999
9999
9999

Enalish (USA)

1Heiser, J., 1993
1 Heiser, J., 1993
1 Heiser, J., 1993
2 Heiser, J., 1993
1 Heiser, J., 1993
1Heiser, J., 1993
3 Per label supplied
1 Heiser, J., 1995
7 Heiser, J., 1995
1 Heiser, J. 1993
2 Heiser, J. 1993
1 Heiser, J. 1993
1 Heiser, J. 1993
1Heiser, J. 1993
3 Heiser, J. 1993

aTl [ Averaae: : Sum

FIE
LD.



Getting Data into Calc

Data files (CSV, XLS, TXT, etc.) are encoded in a specific character-set.

e Most commonly they are either Latin-1 or UTF-8.

GETTING DATA INTO SPREADSHEET TOOLS
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Summarizing/
Slaughtering Data
in Calc



Summarizing/
Slaughtering Data
in Calc

Sorting and Filtering

There are four sort/filter buttons in the
menu bar (left to right):

1.

Sort

2. Sort Ascending
3.
4

Sort Descending

. AutoFilter




SUMMARIZING/SLAUGHTERING

Sorting DATA IN CALC

Sort, Sort Ascending, Sort Descending

'® Sort
Sort Criteria Options
Sort Ascending and Sort | SortKey1
Descending countin o @ o
— The Sort button will open sontkey2
— The two buttons are the Sort window. o — O Ascending
contextual. They will sort EeRy
based on the highlighted — Set Sort Key 1 to “count
cell. in lot” or the column ~indetned Descending

you’'d like to sort.

— Note: Calc automatically
selects all data. — Select Descending or the

desired sorting direction.
IR ITA

Help Reset Cancel “



Sorting

...or use AutoFilter.

To sort data using AutoFilter:

1.
2.

Click the AutoFilter button

Click the dropdown menu button for the
desire column

Select Sort Ascending or Sort
Descending

\

WorkshopDataset.csv

B E-E- 2Lz

m

4‘ iiu E Q'
33~ % 00

G

a

H

W 8

SUMMARIZING/SLAUGHTERING

v

N~]Former numbe[~]count in Ig¥]Specimen identifier's nam{~|Typ{=|Size (mm

299
299
399
299
299
399
299
299
199
299
299
199
299
299
299
299
399
299
299
199
299
299
199

Sort Ascending 1993

Sort Descending 1993

‘ Top 10 1993

Empty 1993

Not Empty 1993

1993

Text Color 4 5
Background Color 3 upplled

1995

Standard Filter... 1995

Search items... L993

1993

1993

Al X 1993

(empty) 1993

! 1993
p , 2003

4 1993

5 1995

° 1993

1993

Cancel OK 1995

3Heiser, J. 1993

52 Heiser. 1. 1993

41
41
41
41
41
41
41
41
43
41
41
41
41
41
41
41
41
41
41
41
41
41
a1

= =

= €=

DATAIN CALC



WHAT ARE SPREADSHEET TOOLS?

What is the difference between
sorting and filtering?

Sorting Filtering
Sorting rearranges the presentation of the Filtering rearrange the presentation of the
data within a table — including all values. data within a table — including only the

values that meet the specified criteria.

In Calc, the AutoFilter button places drop-down menus at the top of each column with options for
both sorting and filtering.

=n
L



Summarizing/
Slaughtering
Data in Calc

Filtering

— O X

LA Wi B Q-
T = @\ 00 [7) Oﬁom >

If you left click the icon, it will
“Autofilter,” placing grey
dropdown menus on all the
columns.

1 tgg)gg; J., 1993 a1 34
1 tmg; J., 1993 a1 15
nnnnn 1 1002 A1 15

SUMMARIZING/SLAUGHTERING

{|Sort Ascending

Sort Descending

Top 10

|Empty
Not Empty
Text color >
Background color »

Standard Filter...

L:ea'cw items..

VAl [x

[V A
V]2

VI3

M4

V15

V6

V17

8 v

< >

OK Cancel

DATAIN CALC



Ctandard

SUMMARIZING/SLAUGHTERING
DATAIN CALC

\

-~

If you right-click on the icon, it will

f - \ open a menu with more options.
Plaie CulsShiftsN You can select Standard Filter to
| [ Open Remote create your own filter.
1 Fg Save As... Ctrl+Shift+S
= = [~ Email
Summarizing/ ¥ s e A /
L] ltd} Print Directly (Canon TS9000 series) /
S Ia u g h te rl n g @.!l Auto Spellcheck Shift+F7 .
d @)\ Navigator b Standard Filter X
Data In Calc Bf»ﬁ Insert Rows Above Filter Criteria
E‘Ja’ Insert Rows Below Operator  Field name Condition Value A
. . ER Delete Rows ; " ; S -1
F||ter|ng FZ Insert Columns Before | LI ’ »
@ Insert Columns After -
E!i' Delete Columns ‘ T =
? Standard Filter ’ ‘ -n v
z Advanced Filter [ Options
v Goal Seek
Lé Gallery Help Clear Cancel
H Formula Object Ctrl+Alt+=

Hm

M

Insert Row Break
Text Box
Edit




Manipulating/
Mangling Data in Calc



MANIPULATING/MANGLING DATA IN CALC

Manipulating/Mangling Data in Calc

Functions
Build your own: Built-in:
— CONCATENATE — Split Text-to-Columns
- VLOOKUP — Deduplication

=n
L



Build Your Own
Functions

Function Wizard:
CONCATENATE

e Syntax:
=FUNCTION(arguments)

e Built-in help offers a syntax
guide:

L NON ]

Functions

Search

Category
Text

Function

Structure

A
v

ARABIC

ASC
BAHTTEXT
BASE

CHAR
CLEAN
CODE
CONCAT
CONCATENATE
DECIMAL
DOLLAR
ENCODEURL
EXACT
FILTERXML
FIND

Array

Help

MANIPULATING/MANGLING DATA IN CALC

Function Wizard

CONCATENATE Function result

Combines several text items into one.

Textl (required)

Text for the concatenation.

Textl  fx =
Text2  fx =
Texts  fx =
Textd  fx =

Result
Formula

=CONCATENATE()

< Back Next > Cancel m



Build Your Own
Functions

Function Wizard:
CONCATENATE

To build the function using the
Function Wizard:

1. Click the Function Wizard button
with the target cell highlighted.

2. Select the function from the
Function box. Use the Search bar
to search for the CONCATENATE
function.

3. Click the Next button.

[ NON
Functions Structure
Search

 —

Category
Text

Function

ARABIC

ASC
BAHTTEXT
BASE

CHAR
CLEAN
CODE
CONCAT
CONCATENATE
DECIMAL
DOLLAR
ENCODEURL
EXACT
FILTERXML
FIND

MANIPULATING/MANGLING DATA IN CALC

Function Wizard

CONCATENATE

Combines several text items into one.

Textl (required)

Text for the concatenation.

Array Help

Function result

Textl fx
Text2  fx
Text3  fx
Textd  fx
Formula pesult
=CONCATENATE()
<Back Next >

Cancel



Build Your Own
Functions

Function Wizard:
CONCATENATE

4. Input cell names and text into the
Text for the concatenation boxes.
For this example: AD3, “-7,
AE3, “-”, AF3 for fields Text1
through Text5.

5. The Result box will allow you to
preview the displayed value of
the cell. Click OK.

[ NON

Functions

Search

Category
Text

Function

Structure

ARABIC

ASC
BAHTTEXT
BASE

CHAR
CLEAN
CODE
CONCAT
CONCATENATE
DECIMAL
DOLLAR
ENCODEURL
EXACT
FILTERXML
FIND

Array

Help

MANIPULATING/MANGLING DATA IN CALC

Function Wizard

CONCATENATE Function result

Combines several text items into one.

Textl (required)

Text for the concatenation.

Textl fx =
Text2  fx =
Text3  fx =
Textd  fx =
EAT Result
=CONCATENATE()
<Back Next > Cancel “



Build Your Own
Functions

Function Wizard:
CONCATENATE

e CONCATENATE(arguments)

X

=CONCATENATE(AD3, ", AE3, "-", AF3)|

AC

| Aab | ae

AF

Site

Year Month Day

[ 1954

7|=CONCATENATE(ADS, "-", AE3, "-", AF3)

1954
1954
1960
1960
1960
1954
1954
1954

d.
8
8
1
0
6

7
7

MANIPULATING/MANGLING DATA IN CALC

AG

AH

Collectors name

AC

AD

AF

Year

Month
1954
1954
1954
1960
1960
1960
1954
1954
1954

=
o O 0 o o

Day

1954-8-7

~N N~




Built-in Functions

Split Text — Columns

Data [Tools Window Help

i Sort...
‘ E.l, Sort Ascending
3 EJ, Sort Descending

¢ N7 AutoFilter Ctrl+Shift+L
| More Filters »
[ [® Define Range..

EE Select Range...

Refresh Range

EZF Pivot Table »
r[?; Calculate »
| Validity...

B Subtotals...

|
i
| Form...
\
\
\
\

:
i
{
&
|
|
1

Streams...
XML Source...

Multiple Operations...

E Text to Columns...
“ﬁﬂmﬁfﬁ’tem—
| @a Group and Outline »

[ e
| liﬁ'_ Statistics »

Text to Columns X
i
Import
Character set: [Unicode (UTF-16) B
Language:  [Default - English (USA) B
From row: |1 =
Separator Options
(O Fixed width (®) Separated by
M Tab [JComma [JSemicolon ~ [“|Space  [JOther
[1Merge delimiters [ITrim spaces String delimiter: " v
Other Options
Format quoted field as text [/ Detect special numbers  []Skip empty cells
Fields
Column type: |
| [Standard _|Standard [Standard | ~
Specimen identifier's name
eiser, J., 1993
elser, o 1993
4 Heiser, J 1993
|5 Heiser, J 1993
|6 Heiser, J 1993
7 Heiser, J., 1993
8 Per label supplied
9 Heiser, J., 1995 v

>

o

= Specimen

MANIPULATING/MANGLING DATA IN CALC

AM | AN
ifier’ name

1993
1993
1993
1993
1993
1993

[N =

bel supplied

=)

1995
1995
1993
1993
1993
1993
1993
1993
2003
1993
1995
1993
1993

cocooToooooooo

Select Text to
Columns... from
the Data menu.

Select your settings in the Text to Column

bottom window.

Wizard. Make sure the right delimiter is
selected by previewing the data in the




MANIPULATING/MANGLING DATA IN CALC

Functions

Calc does not have a built-in deduplication tool. There are two options:

Install an Extension: Use Formatting:
e Remove Duplicates is a free extension e Calc includes functions for conditional
for Calc. formatting and filtering, which can be

used to find and remove duplicates.

=n
L


https://extensions.libreoffice.org/en/extensions/show/remove-duplicates#:~:text=Quickly%20remove%20duplicates%20in%20LibreOffice%20Calc.%20To%20use,Menu%3B%206.%20Change%20options%20and%20click%20%27ok%27%20button.

Functions

Deduplicating Rows

DP number

©O~NDADWNE

B \ c | b | To deduplicate rows,
Cat Numb Accesion year ACC N Fo . .
AbCD1 e highlight the. column to
gﬁ;g iggg gggg sort for duplicates. Under
ABCD4 500 900 Format, select Conditional
ABCD:5 1993 9999 — Condition...
ABCD:6 1993 9999
ABCD:7 1993 9999
ABCD:8 1993 9999
ABCD:9 1993 9999
ABCD:10 1993 9999 Character...
ABCD:11 1993 9999 Paragraph...
ABCD:12 1993 9999 [& PageStyle..
3CD:13 1993 9999 | EZ Print Ranges >
ABCD:14 1993 9999 Lﬁ o , [8 Condition..
A?{Q\QEP{; 1993 9999 1 B AutoFormat Styles... = Color Scale...
g%ig 1332 gggg ] {7 Spreadsheet Theme DataBa:
Aag@ﬁa 1993 9999 : '; Image ! E:t:set
119 1993 9999 | o Chart ' )
A?!Q\Q { ) Object | Manage...
ABCD:20 1993 9999 | Ml Obj
ABCD:21 1993 9999 {  Name.
ABCD:22 1993 9999 ] Description...
ABCD:23 1993 9999 N ehor ,
ABCD:24 1993 9999 [T Armange »
ABCD:25 1993 9999 A Fip R
1993 9999 | I erouwp ,
1993 9999

-

/

MANIPULATING/MANGLING DATA IN CALC

Set the condition to “is duplicate”
and set the style for the
conditionally formatted boxes.

Conditional Formatting for A1:A11794

Conditions

Condition 1

lCeII value

Apply Style:

Enter a value:

is equal to
is less than

is greater than

is less than or equal to

is greater than or equal to
is not equal to
is between

is not between

H11121

is not duplicate
is in top N elements

M AL oL ¥




MANIPULATING/MANGLING DATA IN CALC

Functions

Deduplicating Rows

¢
= Cell Style X
v

| Organizer Numbers Font Font Effects Alignment Borders Background Cell Protection

) None ]
Colors Active New

Palette: |standard v |

N EEEmEmEm
If you haven’t used conditional formatting this way in u. i R 4 =
the program, you may have to create a new style - G [159 G159 [2
that changes the background color rather than font B [207 B 207 [2
Style Hex |729fcf Hex | 729fcf

Pick (o)

Recent Colors

: Custom Palette _
< Add Delete

Help Reset Standard OK Cancel ot FIE




Functions

Deduplicating Rows

Once you’ve formatted any duplicates, use the autofilter
setting. Select Background color from the dropdown menu
to bring duplicates to the top.

From there, check and remove any rows that are duplicates.

MANIPULATING/MANGLING DATA IN CALC

Sort Ascending
Sort Descending

Top 10

Empty
Not Empty

Text color »

Background color

Standard Filter...

Search items...

1Al X]
V10
V120
V145
V1180
V1310
[V]453
V1502 v

< >

oK Cancel




Functions

Deduplicating Rows

Typically, it's best to avoid background
colors because they can make a
spreadsheet look messy.

When removing duplicates, however, all
rows with a different background color
will be deleted.

HQ926
HQ833 B-3
HQ832
HQ515
HQ177

Fo27

|~ Jaccession numbeidldate collected

MANIPULATING/MANGLING DATA IN CALC

AA

9-Sep-85
9-Sep-85
9-Sep-85
9-Sep-85
9-Sep-85

6267
6267
6267
6267
6267
6267
6267

2-VI-84
2-VI-84
2-VI-84
2-VI-84
2-VI-84
2-VI-84
2-VI-84

AB




Build Your Own
Functions

Lookup Lists with
VLOOKUP

=VLOOKUP ( [cell with a value to replace]
[range where column 1 =
matches & column X =
replacements]

[column number X]

FALSE to prevent
approximate matches )

MANIPULATING/MANGLING DATA IN CALC

AL |  AMm AN A | AP AQ AR

=VLOOKUP

VLOOKUP(= Search criterion, Array, Index, Sorted range lookup ) : The value to be found in the first column.

You can type =VLOOKUP directly into the spreadsheet to
use the function. Calc will give you minimal help.

fx X | =VLOOKUP(AP2,Sheet2!A2:F12,3 false) l
|

AJ | AK | A [ S
te ldentified
Nov 1955
Nov 1955 A~ N 2 | AR

Oct 1999 =VLOOKUP(AP2,Sheet2!A2:F12,3 false) I

|



Build Your Own

MANIPULATING/MANGLING DATA IN CALC

Functions

Lookup Lists with

VLOOKUP

=VLOOKUP (

If you want more help writing your function, you can
Insert — Function to open the Function Wizard.

el - LibreOffice Calc
Format  Styles
1 k4 Image...

B

& [

[cell with a value to replace]

[range where column 1
matches & column X =
replacements]

[column number X]

FALSE to prevent
approximate matches )

Sheet

iy Chart..
E:_I' Pivot Table...
Media
Object
Shape

=

Function...
Named Range or Expression...
Text Box
Comment
Floating Frame...

Fontwork...

B = 1IE

Hyperlink...

1
0

Special Character...

@)

Formatting Mark

Date
Time
Field

Headers and Footers...

= EN

3]

Form Control

Signature Line...

Ctrl+F2

Ctrl+Alt+C

Ctrl+K

Ctrl+;
Ctrl+Shift+;

1o

»

»

Function Wizard

Functions Structure

Search

Category

Spreadsheet ﬂ

Function

ERRORTYPE ~
GETPIVOTDATA
HLOOKUP
HYPERLINK
INDEX
INDIRECT
LOOKUP
MATCH
OFFSET

ROW

ROWS

SHEET

SHEETS

STYLE

VLOOKUP v

CAray

Help

VLOOKUP

Vertical search and reference to indicated cells.

Search criterion (required)

The value to be found in the first column.

Search criterion
Array
Index

Sorted range lookup

Formula

=VLOOKUP(

< Back

Next > Cancel

X
Function result Err:511
fx =
fx =
fx =
fx &
Result |Err:511
A

v




Getting Data Out
of Calc



Getting Data
Out of Calc

You can use the “Save As” function
to save the file in a variety of

formats.
e Text CSV e An ODF Spreadsheet
—  Where text delimiter is — The default spreadsheet
specified and applied to all format for LibreOffice,
fields comparable to Microsoft

Excel XLS and XLSX files.

— Readable by most programs

RECAP

Confirm File Format X

This document may contain formatting or content that cannot be
saved in the currently selected file format “Text CSV".

Use the default ODF file format to be sure that the document is saved correctly.

[V]Ask when not saving in ODF or default format

| Use Text CSV Format l Use ODF Format

/

If you attempt to Save directly to the
original file, you will get a warning. To
ensure you don’t mangle any data, Save
As to make a copy, rather than

overwriting the original.




Recap



Recap

RECAP

e Data in spreadsheets: e Alternatives to LibreOffice Calc:

— Good for one-time-use — Google Sheets

— Not good for maintaining — Excel

— ...Is it structured? No. — Not using spreadsheets...?

=n
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G Questions?

Ask now; we might have answers!
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Thank you!
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